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e Theinformation in this document is current as of June, 2008. The information is subject to change
without notice. For actual design-in, refer to the latest publications of NEC Electronics data
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.
Not all products and/or types are available in every country. Please check with an NEC Electronics
sales representative for availability and additional information.

e No part of this document may be copied or reproduced in any form or by any means without the prior
written consent of NEC Electronics. NEC Electronics assumes no responsibility for any errors that may
appear in this document.

e NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual
property rights of third parties by or arising from the use of NEC Electronics products listed in this
document or any other liability arising from the use of such products. No license, express, implied or
otherwise, is granted under any patents, copyrights or other intellectual property rights of NEC Electronics
or others.

e Descriptions of circuits, software and other related information in this document are provided for
illustrative purposes in semiconductor product operation and application examples. The incorporation of
these circuits, software and information in the design of a customer's equipment shall be done under the
full responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by
customers or third parties arising from the use of these circuits, software and information.

o  While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics
products, customers agree and acknowledge that the possibility of defects thereof cannot be eliminated
entirely. To minimize risks of damage to property or injury (including death) to persons arising from
defects in NEC Electronics products, customers must incorporate sufficient safety measures in their
design, such as redundancy, fire-containment and anti-failure features.

o NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and

"Specific".

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-

designated "quality assurance program" for a specific application. The recommended applications of an

NEC Electronics product depend on its quality grade, as indicated below. Customers must check the

quality grade of each NEC Electronics product before using it in a particular application.

"Standard": Computers, office equipment, communications equipment, test and measurement
equipment, audio and visual equipment, home electronic appliances, machine tools,
personal electronic equipment and industrial robots.

"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems,
anti-disaster systems, anti-crime systems, safety equipment and medical equipment
(not specifically designed for life support).

"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control
systems, life support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in applications
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to
determine NEC Electronics' willingness to support a given application.

(Note)

(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its
majority-owned subsidiaries.

(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as
defined above).

M8E 02. 11-1
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CAUTION

This is a Test- and Measurement equipment with possibility to be significantly
altered by user through hardware enhancements/modifications and/or test or
application software. Thus, with respect to Council Directive 89/336/EEC
(Directive on compliance with the EMC protection requirements), this equipment
has no autonomous function. Consequently this equipment is not marked by the
CE-symbol.

EEDT-ST-005-10

CAUTION

This equipment should be handled like a CMOS semiconductor device. The
user must take all precautions to avoid build-up of static electricity while
working with this equipment. All test and measurement tool including the
workbench must be grounded. The user/operator must be grounded using
the wrist strap. The connectors and/or device pins should not be touched
with bare hands.

EEDT-ST-004-10

For customers in the European Union only

Redemption of Waste Electrical and Electronic Equipment
(WEEE) in accordance with legal regulations applicable in the
European Union only: This equipment (including all
accessories) is not intended for household use. After use the
equipment cannot be disposed of as household waste. NEC
Electronics (Europe) GmbH offers to take back the equipment.
All you need to do is register at http://www.eu.necel.com/weee
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Regional Information

Some information contained in this document may vary from country to country. Before using any NEC
product in your application, please contact the NEC office in your country to obtain a list of authorized
representatives and distributors. They will verify:

Device availability
Ordering information
Product release schedule

Availability of related technical literature
Development environment specifications (for example, specifications for

third-party tools and components, host computers, power plugs, AC supply

voltages, and so forth)
o Network requirements

In addition, trademarks, registered trademarks, export restrictions, and other legal issues may also vary from

country to country.

NEC Electronics Inc. (U.S.))
Santa Clara, California

Tel: 408-588-6000
800-366-9782

Fax: 408-588-6130
800-729-9288

NEC Electronics (Europe) GmbH
Duesseldorf, Germany

Tel: 0211-65 03 0

Fax: 0211-65 03 1327

Sucursal en Espafia
Madrid, Spain

Tel: 091- 504 27 87
Fax: 091- 504 28 60

Succursale Frangaise
Vélizy-Villacoublay, France
Tel: 01-30-67 58 00

Fax: 01-30-67 58 99

Filiale Italiana
Milano, Italy

Tel: 02-66 75 41
Fax: 02-66 75 42 99

Branch The Netherlands
Eindhoven, The Netherlands
Tel: 040-244 58 45

Fax: 040-244 45 80

Branch Sweden
Taeby, Sweden
Tel: 08-63 80 820
Fax: 08-63 80 388

United Kingdom Branch
Milton Keynes, UK

Tel: 01908-691-133

Fax: 01908-670-290

NEC Electronics Hong Kong Ltd.
Hong Kong

Tel: 2886-9318

Fax: 2886-9022/9044

NEC Electronics Hong Kong Ltd.
Seoul Branch

Seoul, Korea

Tel: 02-528-0303

Fax: 02-528-4411

NEC Electronics Singapore Pte. Ltd.
Singapore

Tel: 65-6253-8311

Fax: 65-6250-3583

NEC Electronics Taiwan Ltd.
Taipei, Taiwan

Tel: 02-2719-2377

Fax: 02-2719-5951

NEC do Brasil S.A.
Electron Devices Division
Guarulhos, Brasil

Tel: 55-11-6465-6810
Fax: 55-11-6465-6829
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1. Introduction

The 78KO0R - Save It! demonstration Kit shows the system development possibilities using a NEC low power
consumption microcontroller of the 78KOR/Kx3-L microcontroller family.

A preprogrammed sample project, which is written to work with the TK-78KOR demo PC graphical user
interface, provided on the CD-ROM, shows the current consumption in the different operating modes of the
micro-controller.

Furthermore an IAR Embedded Workbench for 78K, IAR visualSTATE and Applilet EZ PL sample projects
for the 78KOR/Kx3-L can be found on the CD-ROM.

1.1 Package contents

¢ TK-78KOR/KE3L board
e USB cable

e CD-ROM containing the TK78KOR/KE3L GUI, Applilet EZ PL, an evaluation copy of the IAR
Embedded Workbench for 78K with 4Kbyte code size limitation and IAR visualSTATE

Please verify that you have received all parts listed in the package contents list attached to the 78KO0OR -

Save It! demonstration kit package. If any part is missing or seems to be damaged, please contact the dealer
from whom you received your 78KO0R - Save It!.

1.2 Features

NEC Electronics yPD78F1009 low power consumption general purpose NEC 16-bit 78KOR MCU
¢ NEC Electronics yPD78F0730 MCU with on-chip USB interface

e 2 latched 7 segment LEDs

e Low current consumption modes demo application with GUI for the Host PC

e Applilet EZ PL graphical based, logic expression design tool, that directly creates the regarding
object code

e On-Board debug function (TK-78K0 debugging)
The 78KO0OR Save It! supports an On-Board debug function by using the IAR C-SPY debugger
without a need of additional debug hardware. It allows FLASH downloading and standard debug
functions like code execution, single stepping, breakpoints, memory manipulation etc.

e Power supply by USB interface or via external power supply

e The IAR Embedded Workbench for 78K and the IAR C-SPY debugger / simulator are included.
These packages are restricted in such that maximum program code size is limited to 4 Kbyte.

o |AR visualSTATE demo, a package of integrated tools for developing, testing, and implementing
embedded applications based on state chart diagrams.

e Full documentation is included for the NEC 78K078F 1009 microcontroller, NEC 78K0 78F0730
microcontroller, IAR Systems Embedded Workbench and IAR Systems C-SPY debugger / simulator.

The 78KO0R — Save It! is not intended for code development. NEC does not allow and does not
supportin any way any attempt to use 78KOR — Save It! in a commercial or technical product.

User’s Manual U19663EE1VOUMO00
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1.3 System requirements

HOST PC A PC supporting Windows 2000, Windows XP or Windows Vista is required
for the IAR Systems Embedded Workbench demo-version.
A Pentium processor with at least 1 GHz CPU performance, with at least
256 Mbytes of RAM, allowing you to fully utilize and take advantage of the
product features. 500 Mbytes of free disk space and an additional 10
Mbytes of free disk space on the Windows system drive.

A web browser and Adobe Acrobat Reader to be able to access all the
product documentation.
Host interface USB interface that enables communication based on USB (Ver1.1 or later)

Note: Updates of the IAR Embedded Workbench for 78K, documentation and/or utilities for
78KOR SAVE IT!, if available, may be downloaded from the NEC WEB page(s) at
http://www.eu.necel.com/78KORSAVEIT

1.4 Trademarks

IAR Embedded Workbench, visualSTATE and C-SPY are registered trademarks of IAR Systems AB.
Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe and Acrobat Reader are
registered trademarks of Adobe Systems Incorporated.

All other product names are trademarks or registered trademarks of their respective owners.

User’s Manual U19663EE1VOUMO00
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2. 78KOR — Save It! Components

The TK-78KOR/KE3L board is equipped with USB-connector and with several connectors in order to be
connected to host computers, FLASH programmer, MiniCube?2 or any external target hardware.

JP1
W1 SW3 SW2
’500 0000 0 0000000006 0060000I™
s50(0) @ -:@II m e O] OINOIO | OFOINO ) OZ @
R a=s -~ —--~ MADE 1 ] - € o
Dot ) i O s
i} ™ —
' |}1‘ - 3 L= [T
- r,I, ; = __I-""‘i" i
-F: 8 5 . JP2
' & : y
assssns] [aaazssisle T ‘i{i
% i - SW4
i f
Q4 )
uio, Uiz SW5 S W6 Universal area

Figure 1: 78KOR — Save It! components

2.1 Operation mode settings

Caused by the different operating modes the 78KOR —Save It! supports different switches and jumpers are
available on the board.

The table below shows the 3 different modes and the regarding switch / jumper setting for each mode.

SW1 DEMO Debug KOUSB

SW2 DEMO EXT KOUSB
SW3.1 — SW3.3 OFF ON OFF
SW3.4 — SW3.8 Unused Any Any

JP1 Short Short Short

JP2 1-2 and 3-4 shorted 1-3 shorted 1-3 shorted

Table 1: 78KOR — Save It! Switch and Jumper settings

2.2 SW1

SWH1 is a 3 position switch to set following modes.

User's Manual U19663EE1VOUMOO0O
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Left Demo
middle KOUSB
Right Debug

Table 2: SW1 modes

2.3 SW2

SW2 is a 3 position switch to set following modes.

Left Demo
middle KOUSB
Right EXT

Table 3: SW2 modes

2.4 SW3

SW3 is an 8 position DIP switch with following functions

Mode selection (see Table 1)

Mode selection (see Table 1)

Mode selection (see Table 1)
Connected to microcontroller port pin P33
Connected to microcontroller port pin P42
Connected to microcontroller port pin P43
Connected to microcontroller port pin P77
Connected to microcontroller port pin P76

ON[D[(O|BA|W|IN|—

Table 4: SW3 modes

Note: Make sure to set the regarding pull-up resistor option registers (PUx) of the microcontroller if
the Pins P33, P42, P43, P76 and P77. Please refer to the device user’'s manual of the
78KOR/Kx3-L for detailed information about the pull-up resistor option register settings.

2.5 SW4 (Reset switch)

SW4 is connected to the external reset pin of the yPD78F 1009 microcontroller. External reset can be
triggered by pushing.

2.6 SWS5 (INTPO)

SWS5 is connected to the "P120/INTPO/EXLVI" pin of the yPD78F 1009 microcontroller. It can be used as
external interrupt source.

Note: Make sure to set up the microcontroller internal pull-up resistor option register (PU12)
correctly when using this external switch. Please refer to the device user’s manual of the
78KOR/Kx3-L for detailed information about the pull-up resistor option register settings.

2.7 SW6 (INTP2)

User's Manual U19663EE1VOUMOO0O
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SWE6 is connected to the "P32/SCK10/SCL10/INTP2" pin of the yPD78F 1009 microcontroller. It can be used
as external interrupt source.

Note: Make sure to set up the microcontroller internal pull-up resistor option register (PU12)
correctly when using this external switch. Please refer to the device user’'s manual of the
78KOR/Kx3-L for detailed information about the pull-up resistor option register settings.

2.8 JP1

JP1 is a switch jumper to select the power supply.

Short USB power supply connected (USB1)
Open Power supply via CN1 or CN2

Table 5: JP1 settings

2.9 JP2

JP2 is a jumper field to establish a current consumption measurement

1-2 and 3-4 short Demonstration mode
1-3 short Debugging/Writing and PC communication mode
any other restricted

Table 6: JP2 settings

2.10 Q4 (illuminance sensor)

The illuminance sensor Q4 is connected to the P80/CMPOP/INTP3/PGAI pin of the yPD78F1009
microcontroller. When lightening up the voltage gains up and when darkening it goes down. So the gain
amplifier function of the microcontroller can be used to read the illuminance. For further information to set up
the registers of the microcontroller to use the gain amplifier functionality please refer to the device user’s
manual.

2.11 U10, Ul12 (7 segment LED)

U10 and U12 are two 7 segment LEDs. They can be set through the latches U11 and U13. The data
channels of the latch are connected to channel P20 to P27 and the clock pins to P00 (U10) and P01 (U12) of
the of the yPD78F1009 microcontroller.

User's Manual U19663EE1VOUMOO0O
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u10 ui2 _ P20 _
[* s [ - L P25 P21
- — — P26 —
P20. P27 & &
= =
3 P24 P22
P00 | P73 | (52?
PO1
Figure 2: 78KOR — Save It! 7 segment LEDs structure Figure 3: 78K0OR — Save It! 7 segment LED port pin connection

In respect to the pin connection the following table shows the port values to be written to show the numbers
from 0 to 9 on the 7 segment LEDs.

Digital number Port value (hex) Digital number Port value (hex)
0 0xCO0 5 0x92
1 0xF9 6 0x83
2 0xA4 7 0xF8
3 0xB0 8 0x80
4 0x99 9 0x98

Table 7: 7 segment LED port values

2.12 LED1 (power LED)

LED1 is the power LED, lights up when power is supplied via USB, CN1 or CN2 to the 78KOR — Save It!

2.13 Universal area

The Universal area of the 78KOR — Save It! is a free for the customer to use mounting area. Furthermore
there is the possibility to mount a MiniCube2 connector to the Universal area

2.13.1 Minicube2 connector

If a MiniCube?2 shall be connected to the 78K0OR — Save It! starter kit a 16-pin connector has to be mounted
to the universal area as shown below.
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Figure 4: 78K0OR — Save It! MiniCube2 connector

Furthermore some solder bridges have to be shorted to connect the connector to the target device.

Figure 5: 78K0R — Save It! Minicube2 connection solder bridges
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3. 78KO0OR — Save It! system configuration

The 78KO0OR — Save It! starter kit system configuration is given in the diagram below

Figure 6: 78K0R- Save It! system configuration

3.1 78KOR — Save It!

The 78KO0OR — Save It! is a demonstration kit for the 78F1009 16-bit low power consumption microcontroller
of the 78KOR family. The demonstration board is connected to the host system via USB interface cable. The
host system may be used for On-Chip debugging by using the IAR C-SPY debugger and to allow execution
of application programs on 78KO0OR — Save It! starter kit.

78KOR — Save It! runs the microcontroller at 20 MHz operating speed in normal operation mode.

3.2 Host computer

The USB host interface enables communication to the 78KOR — Save It! board. The yPD78F0730 78K0 8-
Bit microcontroller with on-chip USB interface and the NEC virtual UART driver allows application software to
access the yPD78F 1009 device in the same way as it would access a standard RS232 interface.

The NEC virtual UART driver appears to the windows system as an extra Com Port, in addition to any
existing hardware Com Ports.

3.3 Power supply via USB interface

The TK-78F0730 board is powered by the USB interface. Optional the power supply can be applied via a
JACK connector which has to be mounted to CN3.
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4. 78KO0OR — Save It! installation and operation

4.1 Getting started

The 78KO0OR — Save It! is delivered with two PC based user programs. The TK-78KORKE3L demonstration
program is designed to measure the current consumption, the CPU frequency and the actual illuminance
(measured by an illuminance sensor). The Applilet EZ PL is an easy to use GUI based program to build up
small logical circuits which are automatically converted into an IAR Embedded workbench or NEC PM+
project. They can be compiled and downloaded to the target hardware directly from within the Applilet EZ
PL; therefore it is necessary that the chosen Workbench Suite is correctly installed on the Host PC.

4.2 CD-ROM contents

MNEL 78KOR - Save It!

CD-ROM ROOT

(3 Acrobat

Acrobat Reader for 32Bit Windows OS

1 Applilet

Applilet EZ PL

1 Device file package

pPD78F8024 Device file package

I Doc - Documentation
1 dotnet - Microsoft .NET package
(3 Driver - TK-78KORKE3L driver files

1 1AR Systems

IAR Embedded Workbench for 78K
IAR visualSTATE

| samples

Example projects for the 78KOR - Save It!
Starter Kit

1 TK-78KOR_KE3L_Demo

TK-78KORKES3L current consumption
demonstration program

1 WriteEZ4

Flash Programmer WriteEZ4 incl. PRM file
for yPD78F1009

Figure 7: 78KOR — Save It! CD-ROM contents
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5. Hardware installation

After unpacking the 78KOR — Save It! demonstration kit, connect the board via connector CN1 to your host
computer using the provided USB interface cable. When TK-78KOR/KE3L board is connected, the USB
driver needs to be installed on the host machine. Please refer to the following USB Driver Installation.
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6. Software installation

The 78KO0OR — Save It! package comes with the following software packages:

e TK-78KOR/KE3L demonstration program

¢ |AR Systems Embedded Workbench for 78K 4Kbyte code size limited, including C compiler,
assembler, linker, librarian and IAR C-SPY debugger / simulator

¢ |AR Systems Visual State time limited demo program

e Device file package of yPD78F1009 for IAR Embedded Workbench for 78K

o WriteEZ4 flash programmer software including the PRM file for yPD78F 1009

NEC

NEC

NEC

NEC

TK-¥8KOR_KE3L
Demonstration program

Applilet EZ PL

IAR Embedded Workbench
+ Visual State Installation

78K0R{Kx3-L Device file
package Installation

Documentation

Exit

Demonstration Kit

78KO0OR/Kx3-L — Save

1]
=
- -

Current consumption and
frequency demonstration

Gul

Empowered by Innovation N E‘

6.1 TK-78KORKE3L demonstration program installation

Figure 8: 78KOR — Save It! CRROM autorun.exe

Before the TK-78KORKE3L demonstration program can be installed on the host PC it is mandatory that
the .NET Framework is installed on the host PC. For further information about installing .NET Framework
please refer to the TK-78KOR_DEMO_GUI.pdf available on the CD delivered with the 78KOR — Save It!
package in the “\Doc” folder.
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To install the TK-78KORKE3L demonstration program just press the regarding button from the Autorun of the
CD-ROM provided within the 78KOR — Save it! package. The setup dialogues will guide you through the
installation process. The installation can also be started by executing the TK-78KOR_KE3L_Demo.msi in
the directory “\TK-78KOR_KE3L Demo” of the CDROM.

6.2 IAR Systems Embedded Workbench for 78K installation

To install the IAR Systems Embedded Workbench for 78K including C-SPY debugger / simulator press the
regarding button from the Autorun of the CDROM provided within the 78KOR — Save It! package. The
installation can also be started by executing the Autorun._exe program in the directory ”\1AR Systems\”
of the CDROM.

When running the autorun.exe the following screen appears.

* H&*ZE [Japanese]

Welcome to IAR Systems

IAR Embedded Workbench® 4K Kickstart for NEC 78K

ﬁ Inztall IAR Embedded ‘w’nrkhenche

Install visualSTATE®

@

Ed
L7

t Helease notes

¥iew the product documentation

Install Adobe Acrobat Reader

L

2 Y ¥k

Explore the CD

]

E xit

SIAR
SYSTEMS

WAk I3 Com

Figure 9: IAR Systems Installation screen

To install the IAR Embedded Workbench for 78K just press the regarding button “Install IAR Embedded
Workbench ®”. The setup dialogues will guide you through the installation process. For further information
about the IAR Embedded Workbench installation refer to the Instal lationGuide_I1AR_EWB._ENU.pdfin
the directory ”\1AR Systems\” of the CDROM.

Note: Please make sure to install the 78KOR/Kx3-L device file package for the IAR Embedded
Workbench, as explained below, before using the IAR Embedded Workbench with the TK-
78KORKE3L board.
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6.3 IAR Systems visualSTATE Installation

To install the IAR Systems visualSTATE press the regarding button from the Autorun of the CDROM
provided within the 78KOR — Save It! package. The installation can also be started by executing the
Autorun.exe program in the directory ”\1AR Systems\” of the CDROM. The IAR Systems Installation
screen will appear and the installation of IAR visualSTATE can be started by pressing the “Install
visualSTATE ®” button. The setup dialogues will guide you through the installation process. For further
information about the IAR visualSTATE installation refer to the “Instal lationGuide_l1AR_VS_.ENU.pdf”
in the directory \1AR Systems\” of the CDROM.

6.4 Device file package of 78KOR/Kx3-L for IAR Embedded Workbench installation

To install the device file package of the 78KOR/Kx3-L for the IAR Embedded Workbench just press the
regarding button from the Autorun of the CD-ROM provided within the 78KOR — Save It! package. The setup
dialogues will guide you through the installation process. The installation can also be started by executing
the dev_install .exe in the directory "\Device file package” of the CDROM.

6.5 WriteEZ4 installation

To install the WriteEZ4 just press the regarding button from the Autorun of the CD-ROM provided within the
78KOR — Save It! package. The setup dialogues will guide you through the installation process. The
installation can also be started by executing the WriteEZ4 V102_EE._exe in the directory ”\WRITEEZ4”
of the CDROM.

6.6 USB Driver Installation

In order to use the TK-78KORKES3L board, the USB driver needs to be installed on the host machine. Install
the driver according to the following procedure:

Installation on Windows 2000 Page 22
Installation on Windows XP Page 26

6.6.1 Installation on Windows 2000

1. When the TK-78KORKES3L board is connected with the host machine, the board is
recognized by <Plug and Play>, and the wizard for finding new hardware is started. Click
Next]
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Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install a device driver for a
hardware device.

Click.

To continue, click Nest.

< Back Cancel |
Figure 10: Found New Hardware Wizard (Windows 2000)
2. Following the window below is displayed. So, check that "Search for a suitable driver ..." is

selected, then click Next>|.

Found New Hardware Wizard

Install Hardware Device Dnvers M
A device driver iz a software program that enables a hardware device to work, with
an operating systern.

Thiz wizard will complete the installation For thiz device:

Check that "Search for a @ USB Device
suitable driver ..." is selected.

[t device driver is a software program that makes a hardware device waork, 'Windows

eeds diver files for your new device. To locate diiver fles and complete the
installation click Next.

Wwhat do pou want the wizard to do?

% Search for a suitable driver for my device [recommended}

Click.
™ Dizplay a lizt of the known drivers for this device so that | can chooze a specific
driver

< Back I Nest » I Cancel

Figure 11: Search Method (Windows 2000)

3. Check the "Specify a location" check box only, then click Next>].
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Found New Hardware Wizard

Locate Driver Files o
Where do you want Windows to search for driver files?

Search for driver files for the following hardware device:

@ USE Device
Check that "Specify a

location" onIy is checked. The wizard sealc;hes fo_r suitable divers in itz driver databa;e on your computer and in
any of the following optional search locations that vou specify.

To start the search, click Mext. If you are searching on a floppy disk or CD-ROM drive,
inzert the floppy disk or CD before clicking Mest.

Optional search locations:

[ Floppy disk drives Click
CO-ROM drives ’
7 i
[ Microsoft \windows Update
< Back I Mext > I Cancel
Figure 12: Driver File Location (Windows 2000)
4. Locate to the folder "CDROM:\Driver”.
Locate File e |
Look jm | i3 Driver j = £5 EB-
[ History
:ﬂ Desktop

5 My Documents

@‘ by Camputer
=4 3% Floppy (&)
== Local Dizk [C:]
= Local Digk (D)
= Local Disk [E:]
= Local Disk [F]
NEC TEKOR-SAVEIT [1)

&
by Mltwork Places

File narne: IMQBES.&LL.inf j Open I
j Cancel |

Files of type; ISetup Infarmation [*.inf]

Locate to “CDROM:\Driver”

Figure 13: Address Specification 1 (Windows 2000)

5. The setup information file “MQB2ALL.inf" is automatic selected, then click to proceed
within driver installation.
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Locate File

Loak jn: Iﬁ Diriver j o~ fj‘ E3-

il

=] MoB25ALL

File name: [MaB2sALL | gpen |
Files af tupe: ISelupInfolmation[".inf] j Cancel |

Click.

Figure 14: Address Specification 2 (Windows 2000)

6. After the location of the USB driver has been specified click @(I to pr

Found New Hardware Wizard x|

|mzert the manufacturer's inztallation dizk into the drive 0K |
zelected, and then click OF.

Cancel |

LCopy manufacturer's files from:

|:MDiriveer

oceed.

Figure 15: Address Specification 3 (Windows 2000)

7. Click [Next>|.

Driver Files Search Results o
The wizard has finished searching for driver files for your hardware device.

The wizard found a driver for the following device:

@ LISE Device

“windows found a driver for this device. To install the driver YWindows found, click Nest.

NEC i‘divermabzsallinf

< Back

Figure 16: Driver File Search (Windows 2000)

Click.

Click.
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8. Click to complete the installation of the USB driver.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

5

_\> MEC Electronics Starter Kit Virtual LART

Windows has finizhed installing the software for this device.

Click.
Ta close this wizard, dlick Finish
<Back i Finsh Cancel |
Figure 17: USB Driver Installation Completion (Windows 2000)
6.6.2 Installation on Windows XP
1. When the TK-78KOR/KE3L board is connected with the host machine, the board is

recognized by Plug and Play, and the wizard for finding new hardware is started. At first the
hardware wizard will ask if windows should search on the windows update web, check "No,

not this time" and then click .

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch for curent and updated softveare by
looking on your computer, on the hardware installation CD, or on
the Windows Update ‘Wb site [with vour permizsion).

Bead our privacy policy

Check that "No, not this time"

is selected. Cah windows contnect to Windows Update to zearch for

software?

() Yes, this time only

XN es, now and every time | connect a device

@1

"l click.
Click Mext ta cantinue.
l Mest » r[ Cancel ]
Figure 18: Found New Hardware Wizard 1 (Windows XP)
2. Check that "Install from a list or specific location (Advanced)" is selected, then click [Next>].
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Found New Hardware Wizard

Thig wizard helps vou install software for:

USE Device

f;') If your hardware came with an installation CD
&2 or Hloppy disk. insert it now.

YWwhat do vou want the wizard to do?

() Install the software automatically [Fecommended)

(#)inztall from a list or specific location [Adwanced§
Check that "Install from a list or .
specific ..." is selected. Click Nest to cantins, Click.
¢ Back II Mest » I [ Cancel ]
Figure 19: Found New Hardware Wizard 2 (Windows XP)
3. Check that "Search for the best driver in these locations.” is selected. Select the "Include

this location in the search:" check box and then click .

Found Mew Hardware Wizard

<1> Check that "Search for the Pleaze choose your search and inztallation options.
best driver in these locations."
is selected.
P-(3) Search for the best driver in these locations.
Uze the check boxes below to limit or expand the default zearch, which includes local
paths and removable media. The best driver found will be ingtalled,
[Ji5earch removable media [floppy, CO-ROM...
Include this location in the search:
<2> Check ‘"Include this
o . ] E B
location in the search: hé
onIy. () Don't search. | will choose the driver ta ingtall
Choosze this option ta select the device driver from a ligt. Windows dog@ not guarantee that
the driver you choose will be the best match for wour hardware.
<3> Click.
’ < Back “ Mest » ] ’ Cancel
Figure 20: Search Location Specification 1 (Windows XP)
4, Locate the folder "C CDROM:\Driver” and click [OK].
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Browse For Folder

Select the Folder that conkains drivers Far your hardware,

I applilet e
I Device file package

& 1= Doc
I dotnet

# L) IAR Swstems
F 155 samples
I TK-78KOR_KE3L Demo
= 155 writeEZ4
= Q My MNebwork Places

+|

To view any subfolders, click a plus sign above,

Ik ] [ Cancel

Figure 21: Search Location Specification 2 (Windows XP)

5. As shown below, "NEC Electronics Starter Kit Virtual UART has not passed Windows Logo
testing to verify its compatibility with Windows XP." is displayed. Click [Continue Anyway|.

Hardware Installation

1] "_\ The zoftware you are installing for this hardware:
L
MEC Electronics Starter Kit Wirtual LART

haz not passzed Windows Logo testing to werify its compatibility
with Windows »P. [Tell me why this testing iz importarnt. )

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor For zoftware that has
pazsed Windows Logo testing.

Click.
Continue Aryway ] | STOF Installation |
Figure 22: Windows XP Logo Testing (Windows XP)
6. After the installation of the USB driver is completed the window below is displayed. Click

to close the hardware wizard.
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard haz finizhed installing the software for:

3 MEL Electronics Starter Kit irtual LART

Click Finizh to cloze the wizard.

Click.

Figure 23: USB Driver Installation Completion (Windows XP)

6.7 Confirmation of USB Driver Installation

After installing the USB driver, check that the driver has been installed normally, according to
the procedure below. When using the Save It! board the “NEC Electronics Starter Kit Virtual

UART” should be present like in the figure below.

Please check in the Windows "Device Manager" within the Windows Properties (“Hardware’

tab), that the driver is installed normally.

3y

£} Device Manager

File  Action  Wiew Help

M ES 2 A =Ra

= =) ETC-LABOR
+ j Computer
go Disk drives
é Display adapters
s DWDCD-ROM drives
=4 Floppy disk controllers
g Floppy disk drives
(=) IDE ATASATAPT contrallers
o Kevboards
™y Mice and other pointing devices
& Manitors
E& Nebwork adapters
= & Ports {COM & LPT)
r;’f Communications Port {COM1)
r;’f Communications Port {COM2)
5 ECP Printer Port (LPTL)
# MEC Electronics Starker ki
+ ﬂ Processars
+ @% =51 and RAID controllers
+- 8, sound, video and game controllers
+]-g@ Storage volumes

+ Syskem devices
+ Universal Serial Bus controllers

F-{H-EH-E-E-H-E-E-EE

Check that "NEC Electronics
Starter Kit Virtual UART (COM?)"
is present.

Figure 24: Windows Device Manager
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7. Demo application using the TK-78KOR/KE3L demonstration program

The Low-Power-Consumption Demonstration GUI for the 78KOR — Save It! is Windows software that can be
used to check the operation of the 16-bit microcontroller 78KOR/KE3-L mounted on the included
demonstration kit board TK-78KOR/KE3L made by TESSERA Technology Inc. by performing a simplified
display of the features and power of the microcontroller.

The Demo GUI allows the user to check the on-chip oscillator of the KE3-L, the power consumption, and the
optical sensor mounted on the TK Board, and to easily switch among the full-speed mode to standby mode.
The current in a user program can also be measured.

i TK-TBKOR/KE3L Ver.1.1

Operation mode selection Trace output Clock Internal , 20MHz

AD-conv :Full time
RTC ‘Running

[Mndlﬂ HMode2 “ Mode3 l [ User ]

Start l

FREQUENCY (internal oscillator)

(MHz)
20220 [T
20
19
OPERATING CURRENT ¥ seale
mA) [ 2omA | 2mA || 200pA || DAGEEH)

.

ILLUMINANCE
Digital Value {Hex):

00CA 0Ox03FF

Lux:

ux o B

Figure 25: TK-78KORKE3L demonstration program

Note: Values displayed on the GUI
Reference values are displayed on the GUI. Results that do not satisfy the device
specifications might be displayed depending on the resistor for detecting current and the
resonator or measuring the frequency used on the board. Use the values only as a reference
for design and evaluation. Use calibrated measuring equipment if precise measurement is
required.

For further information about usage and functionality of the tool please refer to the TK-78 KORKE3L
demonstration program User's manual (TK-78KOR_DEMO_GUI . pdf). The manual can be found on the
78KOR — Save Itt CDROM in the “\Doc” folder.
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8. Applilet EZ PL

8.1 Overview

Applilet EZ PL is a software tool that can be used to automatically generate microcontroller software by
using only its GUI (graphical user interface) when installed on a host.

By using Applilet EZ PL, the basic operations of systems using a microcontroller can be learned and
evaluated without knowledge of complex programming languages.

i Applilet EZ PL [ TK-7BKORMKE3-L ] - Sawve-It.loc
File Edit Wew Run Settings Help

o
) = S [& = £
Mew  Open Print  “Wiew Start Euild
— ~
=
g | Input Output |Diy<ita| in ‘:
£ bipsw
= . \
= L_ Dipsie-—d Fna lox in H
i _ﬁ Dipsu |- . ) =
= |n' SUE-5 : b ]
m | £ uarro in J| |
o " + | oo
- _\| s =
- DipSiiz-5 3
— F — uaRT1 in | <
ip
m
i |nipsw3—? : D: I 5
| | —
Dipswa-8 =)
=
— L]
M.

Push Buttan
us igital out
Fush Buttan [>_.|Tirrer| Fen
SE Ir | Segment Julse
[m]
(=L
FM oot
E I
lumrro out

i

EE

AJARTT out

194y ¢
@Y

[
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|
=1
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L
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i
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z

+:
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+.

L
[
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&
m

i
=
&

[

esat]

HiE

£

(=]

< b4

* | Build lSimuIate]HeIp ]

--, - |ROM Capacity : 14kbyte

Figure 26: Applilet EZ PL main window

8.2 Features

e Automatic generation of object code for the 78K0/Kx2, 78K0S/Kx1+, 78KOR/KE3-L, and
78K0/KC2-L
Applilet EZ PL can be used to automatically generate object code (*.hex) and a source file, which
can be written to the flash memory in the 78K0/Kx2, 78K0S/Kx1+, 78 KOR/KE3-L, and 78K0/KC2-L,
by assigning GUI panels, which represent the various functions of a microcontroller, to the input,
processing, or output block area.
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Therefore, software can be generated without special knowledge of programming languages
supported by the 78K0/Kx2, 78K0S/Kx1+, 78 KOR/KE3-L, or 78K0/KC2-L.

Simulation
Applilet EZ PL can be used to easily simulate and check the operations of the target system.
The operation can be checked on the PC without the target system by using this simulation function.

Automatic generation of a project file for the integrated development environment

A *.prj project file for the integrated development environment PM+, made by NEC, or a *.eww
project file for the integrated development environment IAR Embedded Workbench, made by IAR
Systems, is automatically generated at the same time as the object code (*.hex).

By using this project file, the source file (*.c or *.h) generated by Applilet EZ PL can be easily
reedited or recompiled in the integrated development environment of each company. [Note]

Note: Only a source file supported by the integrated development environment PM+, made
by NEC, is generated for a low-pin-count microcontroller (78K0OS/Kx1+).

Evaluation board
By using Applilet EZ PL with an evaluation board, created software can be easily checked.

For further information please refer to the Applilet EZ PL User's manual (U17656EJ6VOUMOO . pdf) available
on the 78KOR — Save It! CD-ROM in the “\Doc™ directory.

8.3 Applilet EZ PL demo application

The now further described demonstration application can be found on the 78KOR — Save It! CD-ROM in the
‘“Nsamples\Applilet EZ PL startup sample” directory.

The Applilet EZ PL demonstration project is an easy logical circuit where the both 7 segment LEDs of the
TK-78KORKE3L board are toggled, with the set up toggling rate of 0.5sec, depending on the switch settings
of the board (shown in Figure 26). To let both 7 segment LEDs toggle it is mandatory that the switches
SW3.4, SW3.6 and SW3.8 are set to ON, switches SW3.5 and SW3.7 to OFF and the switches SW5 and
SW6 are not pressed. If any of these settings are changed the LEDs will stop toggling.

Switch Channel Position
SW3.4 ON
SW3.5 OFF
SW3.6 ON
SWa3.7 OFF
SW3.8 ON

SW5 + SW6 OPEN

Table 8: Applilet EZ PL demo Switch settings
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9. Flash Programmer WriteEZ4

WriteEZ4 is flash programming software to flash hex files to the related device. For installation information

refer to the chapter WriteEZ4 installation.

WriteEZ4

File Dewice Wiew Help

At Y4

»» FlazhDpenning....

Flazh Open Ok

»» ParameterFile Feading....
Success Read ParameterFils.
»» LoadFile Reading....
Success read HEX file)

Ready

Device
MHame :

Firm Wersion :
ExtCode :
Yendor

Parameter file
MHame : 78F1003
Farmat : 0419
Wersion : W1.00
Processarer. 0200

Load file

Mame  DEMO_FIRM_KE3LHE
Date: 200841109 03:4712
Chiksurn : GO0 Ch
Area:  000000R-D0FFFFR

Comnection o device
Part : COm4
Speed  115200bps
Fange Chip
Freq.: Internal-05C
tultiply - 1.00

MM

Figure 27: WriteEZ4 Startup

9.1 Device Setup

To provide all necessary information about the device to be programmed, only the corresponding flash
parameter file must be loaded. The parameter file (*.prm) for the yPD78F1009 is located on the CDROM, in
the same folder as the WriteEZ3 setup file. Please use the menu “Device -> Setup..." to open the following
dialogue and the button “PRM File Read” to select the parameter file.

EZ Device Setup

Standard ] Advance l

Host conmection

[~ Target Reset Mezzage

Farameter file | 78F1003.prm

Supply ozcillator

Portt Toimg - Frequency
Speed Multiply rate
Operation Mode
'3 Ehlp Start
" Block End
*ﬁ B

3

0K

Cancel

Figure 28: WriteEZ4 Device Setup Dialogue
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Please check that the correct host communication port is selected. The used communication port can be
seen in the Windows Device Manager.

9.2 Using WriteEZ4

After a successful device selection the internal flash memory can be blank-checked, erased, programmed or
verified. WriteEZ4 can be controlled either by menu or by buttons

B WriteFZ4 Mf=1E3

File BMEUW-N Wiew Help

Blank Check.
Erase
Prograrm Device
Yerify Harme :
Security Firm “ergiah :
Checksum ExtCode :
Wendor :
AutoprocedurelEPY) Parameter file
Signature read E;:;Eat: . EE%UDS
Get Security settings \ersion - Y100
cet Processor VYer. 0200
etup...
" Loadile

Mame DEMO_FIRM_KE3LHE
Date:  2008/11/09 094712
Chlkzum :BODCh

Area:  000000b-00FFFFR

Connection to device

Port:  COM4
Speed  115200bps
Range Chip

Freq.: Intemal05C
Fultiply : 1.00

Figure 29: WriteEZ4 Device Menu

/L@j device setup button

load file button

blank check button

d

L~

erase button

y program button

verity button

%ﬁ Autoprocedure button

Table 9: WriteEZ4 action buttons

WriteEZ4 supports Intel-Hex and Motorola S-record file formats as input file.
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10. Erasing the flash memory (using the WriteEZ4)

If the preprogrammed software is written to the flash it is mandatory to erase the flash of the device before it
is possible to use the Applilet EZ or the IAR Embedded Workbench with the TK-78KORKE3L board. To
erase the flash please perform following steps.

1.

5.

6.

Make sure that the TK-78KORKES3L board is in the Debugging/Writing mode. (78KOR — Save

It! Switch and Jumper settings)

If not already connected, connect the TK-78KORKE3L board via USB1 connector to the
target device.

Run the WriteEZ4 flash programming software.

Select the right .prm file as explained in chapter 9.1 Device Setup. The regarding
78F1009.prm file can be found on the CDROM in the folder “CDROM\WR I TEEZ4\PRM

files”
Open El E|

Lack jn | £ PRM files Bl

File name: |?8F‘I 003.prm
Files of tppe: |PHM Files* PRI) ﬂ Cancel

Figure 30: WriteEZ4 open .prm file

Click the erase button

After finishing the flash erase following message shall apply

WriteEZ4

File Dewvice \iew Help

NP K Y4

>>COMMAND: Eraze Device
Flash Blark Checking... Hame : D78F1003
Flash Erasging...
chip eraze finish. Firm Yersion ;. 1.00
ExtCode : EFD4DCFDR
Yendor ; 10h
Parameter file
Name : 78F1009
Formnat : 0419
Yerzion : 31.00

Processor Yer. 0200

Load file

MName  DEMO_FIRM_KE3LHE
Date:  2008/11/090%:47.12
Chiksum :60DCh
Area:  000000h-O0FFFFh

Conkection to device
Port:  COK4
Speed  115200bps
Range Chip
Freq.:  Intemal05C
Fultiply : 1.00

Ready MM

Figure 31: WriteEZ4 flash erase successful

If so the device flash is successfully erased.
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11. IAR Embedded Workbench 78K0OR — Save It! sample project

The IAR Embedded Workbench IDE is a very powerful Integrated Development Environment that allows you
to develop and manage a complete embedded application project.

The now described project can be found on the 78K0OR — Save It! CR-ROM in the “\samples\TK-
78KORKE3L startup sample” folder.

To run/debug the project with the IAR C-SPY debugger it is necessary to follow the steps described below in
this chapter.

For further information about the IAR Embedded Workbench ant the included functionalities please refer to
the regarding User’s manuals available on the — Save It! CR-ROM in the “\I1AR Systems\doc” folder.

Note: Make sure that the Flash memory is erased properly before first download the project to the
target device. Refer to the chapter Erasing the flash memory (using the WriteEZ4).

11.1 Hardware setup

To run the program it is necessary to set up the TK-78KORKESL board in the following way.

Switch / Jumper Mode position
SW1 Debug
SW2 EXT
SW3.1 — SW3.3 ON
SW3.4 — SW3.8 Any
JP1 Short
JP2 1-3 shorted

Table 10: IAR EWB 78KO0R — Save It! sample project hardware setup

11.2 Loading the Save It! sample project

After starting the IAR Embedded Workbench for 78K the Startup window pops up. In this window you are
able to choose the Open existing workspace button.

r
I._DI Create new project in current workspace
Add exigting project to current workspace

Open existing workspace

Example applications

Recent workspaces:

Open

™ Do not show this window at starup

Cancel

Figure 32: IAR Embedded Workbench Startup window
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Then locate the sample project on the CD and open the SAMPLE-TK-78KORKE3L . eww workspace file.
Afterwards the IDE should look similar like below.

#% IAR Embedded Workbench, IDE

File Edit Wiew Project Tools Window Help
b= | [=] TE S0
E x - x
|Debug -l " EO0unsigned char g start: -
Hles i | B, 1 5lunsigned char g_led = 0;
52 unsi d char count = 0;
B (J SAMPLE-TK-78KURKE3... v | saunsioned char o ied s - 10:
B intc > . ga -
B int_userc B (R
[ main.c - ' 56 %
B portc . R
[ port_userc . | 5g s
Brcc - : 59 ##  Abstract:
rtc:_user_c: * : 60 #+ Thisz function implements main function.
[ system.c * © Bl
[ system_user.c . : 62 #%  Darameters:
[ systeminitc * L B Hone
[ timer.c « ;o B4
B timer_userc . D] Returns:
1 [ Output : :3 :: Hone
68 EED
69 s
70 void main(woid)
714
72 g_start = Z;
73 while (11
74 {
75
76 g led 5 = 0;
E 77 while| g_start == 0 ){ £ LED blink
P } -
seveetkraorken | gl (1) | f
= Messages File
>
Ready Errors 0, Warnings 0 MM =
—_

Figure 33: IAR Embedded Workbench Main IDE window

To verify that the right debugging device is chosen please open the project options window by clicking
Project = Options and then open the tab Debugger.

Note: Although the On-board debug interface is used, the MINICUBE C-Spy driver must be selected
instead of the standard driver TK-78K used for other starter kits. If the debug session via
MINICUBEZ2 and the OCD1 connectors shall be started, also the MINICUBE C-Spy driver must
be selected.

The corresponding COM port where the TK-78KOR/KE3L board is connected to the host PC will be detected
automatically by the IAR C-SPY debugger.
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Options for node "SAMPLE-TK-78KORKE3L™

Categarny: Factary Sethings

General Options
C/iZ++ Compiler

Assembler

Custom Build Setup l Extra Dptians] F'Iuginsl

Build Actions .

Linker Diriveer

" Debugger |MINICLIBE GB-73KOMIMI, GB-72K05msebIMI, QB-MINI2j

IE-78 v Funto
IECUBE :
MIMICUBE |min
Sirnulatar Setup macros
TE-73

[ Usze macro file

| B

Device descrptions
[ Owerride default

ol

ak. | Cancel |

Figure 34: IAR Embedded Workbench Debugger Options

The next step is to check that the correct linker settings are set. This can be done in the “Linker” category as
shown below. Select the “Config” tab and check that the linker command file “Ink78f1009.xcl” is selected.
This file is used by the linker and contains information on where to place the different sections of code, data
and constants that may be used within the demo project:
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Options for node “SAMPLE-TK- 78KORKE3L*

Cateqaony:

CliZ++ Compiler
Assembler
wisualSTATE Coder
Custam Build
Build Actions
Linker
Debugger

IE-73

IECUBE

MINICUBE

Simulatar

TK-73

General Options

Dutput] Eutra Elutputl #define] Diagnastics] Ligt

Linker command file
Iv Owverride default

Factary Settings

Canfig lF'n:nce 4 »

$PROJ_DIR$[%

[ Owerride default programm entry
g |
~

Search pathzs: [one per ling)

N

$TOOLKIT_DIR$ALIES

Faw binarny image
File:

Segment:  Align:

| |

| [

o]

Cancel |

Figure 35: Embedded Workbench Linker Configuration

Now after everything has been setup correctly it's time to compile and link the demonstration project. Close
the Options menu and select “Rebuild All” from the “Project” menu. If the project is compiled and linked
without errors or warnings it can now be downloaded to the 78KOR Save It! board and debugged.

To start the IAR C-SPY debugger select the option “Debug” from the “Project” menu or press the (

“Debugger” button.

2 )

When first starting the debugger connection, after building the project, it is necessary to set up the right
connection settings. Please take care that the following settings are chosen:

e |D code = FFFFFFFFFFFFFFFFFFFF

e Main clock = External 20.00 MHz

e Sub clock = External 32.768KHz

e Target connect = TOOLO+TOOL1
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MINICUBEZ Hardware Setup for 7BKOR [7BF100964)

D code
FFFFFFFFFFFFFFFFFFF

tain clock
i

{+ External
~

Flazh programming

| Erase flazh befare next |0 check

|2EI.IZIIZI | MHz

Tirne unit

nzec e |

Sub clock
i

{+ External
~

|32.?EB | kHz I

Target power aff

&
Cancel
[

Drefault

T arget connect

* Permit " Perrit
TOOLO+TOOLT -
" Mat Permit f* Mot Permit | " J
Pin mazk Peripheral breal:
[ [ TARGET RESET & (timer) -~
[ [ INTERMAL RESET [ B [zenal etz f"
b emary map
Start address: Length: Type:
960 - Internal ROM ~| Add |
000000 - Ox0FFFF Internal ROM B4 Khbytes
0=FF300 - 0xFFEFF Intemal Rakd 3072 bytes
Remove |
Remove All |

Figure 36: IAR Embedded Workbench MINICUBE?2 settings

Now the debugger is started and the demo project is downloaded to the 78K0OR Save It! board. The progress
of downloading is indicated by blue dots in the MINICUBE Emulator window. Please note that downloading
of larger executables may take some time.

After the download was completed all debug features of IAR C-SPY debugger are available, i.e. Single
Stepping, Step Over/-In/-Out, Go-Execution, Breakpoints, Register / Memory view etc.

To get more details on the debugger configuration and capabilities please refer to the “78K IAR Embedded
Workbench IDE User Guide” of the IAR installation.
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/ IAR Embedded Workbench IDE EEX
Fle Edt Wew Project Dsbug Emulstor Tooks Window Help
iR = - y: ® I WL R
= 22 LE22 R
[ ot | -x x
|Debug j T 67 % j Expression Value Location Type
Eiles e B R 10 Memory:0xFF3... unsigned char
F = 1= 0 Memaony:IxFF3. unsighed char
B[ SAMPLE-T... v ! 700id main{veid)
int.c B
o
main.c Lo
parte Rt
i 75
6 g_led s = 0; ]
77 3
78 INTPZ Disable(); o INTE2 mask Goto x| [Memony |
79 RTC_IntervalInterruptDisable () ; #* RICI int 31. 00202 714BE4 CIE1 MED . 4 -~
80
a1 & ohaRe = 0 00205 o7 RET
Biirier. userc 82 TDROO = _54D5_TAU_TDROO_VALUE; /: set timer fr INTEZ Disable:
L 3 Output :3 TAUD_Chanmel0_Starti): / ™0 unmask 00206 714AF4 SET1 I.{I(D 4
85 while ( g_start ==0 ) { o slewly & sto o209 714BED CLRL thlA
86 if ( g_led s >= 50 ){ no20c o7 RET
87 TAUD ChannelO_Stop(); /% MO mask
88 g_start = 1; HD_TNTED
i THTFO_Ensble () ; i TR 00200 CFOEF302 HOY Hig_start. #0z02
90 RTC_CounterEnable() ; #* RIC int unma 00211 G1FC RETT
91 ¥ ;
92 ' HD_INTPZ
93 00213 FEOEF3 CLRE H:g_start
i ) 61FC RETI
95 while( g_start == 1 ){ o LED blink
e ¥ i 1 5
97 00218 F506F3 g Nig_start.
98 INTPO_Disable(); o INTFO mask N01B EF32 BR SEeHDEeY
i 93 RTC_CounterDisable() ; o RIC int mask 0021D GFO0E3 MOV & M TR
i 100 RTC_IntervalInterruptEnsble (INTERVALA); /% RICI int 31. 00220 4C32 CHE A, #0=32
1101 INTPZ_Enable(); o INTEZ ummask gozzz Dcoc BC $+0=0E
i L AU0 ] 0
i e while( g_start == 2 )1 - SRR 00224 FDF&04 CALL H:TAUD_Channell_Stc
io104 I3 00227 ES06F3 ONEE H:g_start
i .| )
I 106 00224 FDF101 CALL H:INTPO_Enable
i . % 0022D  FDBS02 CALL  H:RTC_CounterEnsblew
SAMPLE-TE-78KORKE3L I\C[]l “ | » < >
b Messages File Linge

Building configuration: SAMPLE-TK-78KIRKE3L - Debug
Updating build tree

Configuration is up-to-date

|- oeboalon Buid

Ready Errors 0, Warnings 0 UM

Figure 37: IAR C-SPY debugger

LI

11.3 Running the application

After downloading the project to the device the debugger window opens and, if not changed by the user, the
program runs to the first instruction of the main() function. When reaching this point the necessary clock
initialization is already executed.

This sample project makes use of different timer interrupts to control the 7 segment LEDs available on the
TK-78KORKES3L board. So this project gives a short overview about timer initialization and timer interrupts
usage of one timer array unit (TAU) channel as well as the real time clock (RTC) peripheral.

11.3.1 Count mode

When resuming execution of the program, after the break when entering the main function, the controller
starts to count up from 0 to 49 on the 7 segment LEDs. This is controlled by the TAU channel 0 which is
initialized as an interval timer. Furthermore every time the interrupt occurs and the value is counted up the
interval time increases. During this stage both external interrupts INTPO and INTP2 are disabled.
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11.3.2 Blink mode

After the counter reached its final value of 49 the used timer interrupt is masked and the RTC interrupt will
be unmasked and is used for the next stage. Furthermore the INTPO is unmasked to be able to leave this
stage whenever the user wants to.

The only function of this stage is to let the final counter value blink in a frequency of 2Hz controlled by the
RTC interrupt. To leave this stage only SW5 has to be pressed once.

11.3.3 Spinning mode

When entering the Spinning mode the RTC interrupt and the INTPO will be masked. In exchange the RTCI
Interrupt, which occurs every 31.25ms and the INTP2 are unmask. The function of the Spinning mode is to
spin 1 active segment around the 2 7segment LEDs. So every time a RTCI interrupt occurs the active
segment is stepped clockwise to the next segment on the outer ring of both 7 segment LEDs. To leave this
mode the SW6 has to be pressed to trigger an external interrupt. When leaving the spinning mode the Count
mode is entered again.
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12. IAR visualSTATE 78KO0R — Save It! sample project

IAR visualSTATE is a Windows-based software package of integrated tools for developing, testing, and
implementing embedded applications based on state-chart diagrams. It includes a graphical design
environment, test tools, a code generator, and a documentation facility.

IAR visualSTATE has been developed in accordance with the Unified Modeling Language notation (UML).

For more information please refer to the UserGuide . pdf included to the 78KOR —Save It! CD-ROM in the
“Ndoc\visual STATE” folder or to the visualSTATE homepage

The in the following described sample project can be found on the 78KO0OR - Save It! CD-ROM in the
‘“Nsamples\I1AR visualSTATE sample project” folder.

12.1 Hardware setup

To run the program it is necessary to set up the TK-78KORKESL board in the following way.

Switch / Jumper Mode position
SW1 Debug
SW2 EXT
SW3.1 — SW3.3 ON
SW3.4 — SW3.8 Any
JP1 Short
JP2 1-3 shorted

Table 11: IAR VS 78KO0R — Save It! sample project hardware setup

12.2 Functionality of the sample project

The example implements a reaction timing measurement application that measures your reaction time a
fixed number of times and then displays the average reaction time in hundredths of a second. The
application

works in the following way:

e When the application is started it displays two '-' characters on the display and waits for a press on
any of the two buttons.

e A timer with a fairly random interval is now started and when the timer times out a [' or 'T' symbol is
displayed on the left or right digit respectively. A new timer is also started for the measurement of
your reaction time.

e You should now as fast as possible press the left button if the ' is shown or the right button if the 'T'
is shown. The time for you to react is read from the timer and added to a running sum.

e After a button press the process is repeated until 10 trials has been performed. Your average
reaction time is now displayed and you can press a button to get back to the initial state and restart
the measurement if you want to.

The state machine is implemented with 3 input events (button presses and an expired timer) and 10 small C
functions for the interface to the hardware. There are 5 states to keep track of what is currently going on in
the application. This is not the only plausible state machine implementation for this application. An
alternative

could for example be to have separate, parallel and communicating state machines for time measurement
and display updates.

Further details on the sample project can be found in the index.html file available in the 78KOR — Save It!
CD-ROM ““\samples\visual STATE\doc™ folder.
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12.3 Running the sample project

To perform changes on the visualSTATE parts open the visualSTATE workspace file within the
‘“Nsamples\IAR visualSTATE sample project\vS” folder of the CD-ROM. After loading the

workspace the window should look like shown below.

‘ £ visualSTATE Navigator [Demo] - [StartNoAnimation. htm]

D Fle Edit View Project Tools Window Help Jﬂ&
! D E BE S EGE address | :ems\visualSTATE 6.1 DemolDoc|Starthodnimation.htm | 2603
1
==

= rr?g React: 1 Project(s)
= % React : 1 Systemls)
% Reaction
=423 Validatar warkspaces
¥ React.vivs
[Z Test Sequence Files
=423 Repoits
BB yscodercre
% React.htm
BB yscodercre MODELING

% React.itf

PROJECT

MANAGEMENT

CODE GENERATION

=
|

‘. General 4 Code Generation » ‘erificstion jDocumertation Custom Commands (J

Figure 38: IAR visualSTATE navigator

If the functionality or the settings of the sample shall be changed open the visualSTATE Designer.
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Eile Edit ¥iew Insert Format Tools window Help

=H &l M BME W Qg e Th - e

* n.Reaction - (Statechart Diagram)
= React: 1 System(s]
=-8& Reaction [ ; AT TEweT TEqUITEmEntE Tor an APPTCaTIon ThaT MeSsures your 123
= [ Reaction ime
O InitState B In tState AnyButton ¢ escription:
Entry / InitS othware Timers(y he application can be started by praszsing one of the buttons.
O Test [eSumReactionTime=1] hen the application randomly selects S5 or SVIS for you to press. It
{0 DisplapResult [iNTests = 0] Displaylnit. ells you which ane to press by showing something at the display. After
O Measure ~ hat it shows you your reacdion time in milliseconds,
O <niials - bitter randomly selecting 2 button foryou to press 10 times, it displays the
werage reaction ime by switching bebween "4 and your reaction time
) WrangButton = Test teszing the wiong button before the conect one should be "prohibited”
Entr / [iButtani:hoice =GelectkandomBution(] ' some way
< AnyButton ¢ [iTimeBetmeenT ests = SelectTimeBebuen T esta)]
i i Test(aTi T ired,
TimeRetueenTests)
Q Entry / DisplayClean)
®
@ [Collection of possible events (Derived fam high-level I~
eTimeBetubenTestEspire ppecification)
® i leButtons: Indicates user has presced button SWS conscted to INTPD
WrangBution leButtont: Indicates user has pressed button SUIS conected to INTPZ
@ Entry [ [INIT asts = (N7 asts-1] eButtons() leTimeBebueenTestsExpired: The time from prewious button press until
Displayinitialhdessage: eButtons( [iMTlests<oNumberDT ests] nexd test
" . [iNIT ests< cNumberfT ests s . ! !
® [iButter(Cheice == 0] / [iButtenChaics == 1] ftopRAa Collection of pessible action functions:
StopReactignTimerAndRead)) isplaylnitialMessage: Showsomething on the displaywhen application
[ ] is stated
] <Buttons0 DisplayLeftRight: Display symbol on 'left or'right digit to indocate S
e C o 1o Ehean o1 WS buttan to press
i |Enty7 (NrTesE= iNmessr isplayResult: Show awerage result of reaction tests
DisplayLefiRightiB utten Ghaive) StartReastion Timei) [StartfieactionTimer: Starttimer for reaction measurement. This iz not a
timer action, since it is free running
Q eButtonfiy SelectRandomBution: Randomize which button user should press
(ButtonChoice =, TimerctionTimeBetmeenT ests: Start the timer that determines the
interval between tests. Thisis a pure imer action thatshould specify an
lewent to be posted when the timer expires
eTimerOverlon) £ topReactionT ad: Stop the timer and read out
bisplayClaam he count value
StopReactionTime rhndRe eButtonQ|[HIT ests == cHumberOfTests] eBittona0) [iNTests = SelectTimeB etweenTests: Returm a (possibly randomizedyalue for the
[iButtenChaice ’ cHumberOf[l este] [iButtonChejce == 0] [interval between tests
it ctionT 0 i StopRdactionT adg  [DisplayClear Tum off all segmens in the display
InitS oftware Timers:
AnyBution ¢ StopSoftware Timers: Functions to init and stop the sofiware timers and
SHapBnfimare Time =) [ DT | he commaspanding hardware timer.
f..u 7 Displayresult) J
v
¢ >
* [Loading file: C:AT emph78KOR_5 aveitvs \Feaction. var F
- Aeading local elements...
- Reading state information...
- Reading Transition5tate Reaction information,
- C:ATemph7BKOR_S aveit\wS\Reaction.vsr loaded.
Froject: C:ATemp\TaKOR_SaveitwS\React vsp laded
1 Swstemlz)
2Filefs] Mi
H Source Cortrol Ll
Ready (1226, 140) 75%

Figure 39: IAR visualSTATE designer

To run the project on the TK-78KORKES3L board locate the IAR Embedded Workbench workspace file within
the “\samples\IAR visualSTATE sample project\EW” folder of the CD-ROM.
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/' 1AR Embedded Workbench IDE

File Edit Yiew Project Tools Window Help
DEeE@ & | =l wmEe By YR B D
x ¥5_ActionFunctions.c & E3
|Debug - CSpylLink j i 1 I
H FY
Files fo | B ! gz}nciuge macr;d;lver}.}h
include "userdefine.h”
BOISAMPLET... v 4 #include "V3_SoftwareTimers.h™
_E-‘DEB_”@“B“B : 5 #include "i078£1009_64.h"
SImpleE_._ 1 6 #include "timer.h”
&1 (0 SofwareTi.. : 7 #include "Reaction$EMLibE.h”
B vs_Soft.. LB
2 OvSCaoder ! 94#if (READABLE==0)
[ Reactw... | 10#include "ReactionData.h”
[ cstartup 526 1l ginclude "Reactiondction.h”
B intc | 12 #endif
B int_userc ;13
main.c E ldconst unsigmed char TIMEE_ ID TIME BETWEN_TESTS = 0:
B port.c T ) N
port_user.c E 16 ¥5_V0ID DisplayInitialMessage (V3_WOID)
= [ systern.c i;{ P2 - OxBEs e 1ot %
[ systern_us... - };itxmé s 7
B systeminit. 20 PO_bit.nol = 1:
B timer.c 0 - .
- ' 21 PO = 0Ox00;
B timer_userc Loz
[ Vs _Action... [
&1 (1 Output L 22
[ SAMPL... | 25V% V0ID DisplayClear (V5 _V0ID)
L 264
27 PO = 0;
28 P2 = OxFF;
29 PO _bit.nol = 1;
3 30 PO_bit.nol = 1;
i 31 PO =0:
- =
SAMPLE-TK-78KORKESL [fo] [« |+
&3 .
Messages File
< >
Ready Errors 0, Warnings 0 Ln 1, Col 1 MM —
—

Figure 40: IAR Embedded Workbench visualSTATE sample project

When loading the visualSTATE sample project all necessary settings to run the application on the TK-
78KORKES3L board are already set. So the user just has to download the application to the target device.

The application can be downloaded by click Project > Debug.

Note: Make sure to erase the memory of the target device properly before the first download of
the visualSTATE sample project by using the WriteEZ4 as described in chapter 10.

12.4 Debug the 78K0R — Save It! visualSTATE sample project

After downloading the application to the target device all from the C-SPY debugger already known debug
features are available. Furthermore more visualSTATE specific Debug features can be used like an actual
State view or a graphical animation of the states and state switches. For further information about the
visualSTATE C-SPY plug-in please refer to the regarding chapter in the C-SPYLinkUserGuide . pdf which
is available in the “\doc\visual STATE” folder.
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13. Cables

13.1 USB interface cable (Mini-B type)

A —

Series "A” Plug Series "Mini-B” Plug

Series "A" Plug  Series "Mini-B” Plug
&

i

<

=< [T B

Figure 41: USB interface cable (Mini-B type)
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14. Schematics
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Figure 42: TK-78KORKE3L schematics 1/3
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Figure 44: TK-78KORKE3L schematics 3/3
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